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1
Getting started with PrintWhere
PrintWhere® is a universal Windows print driver that lets you print to any
PrinterOn registered printer to which you have access directly from any
Windows application.
PrintWhere appears as just another printer that you can choose when you print
from any Windows application. However, rather than pointing to a single
printer as most printer drivers do, PrintWhere acts as a gateway to the
PrinterOn Directory of printers.
You can quickly choose and print to a previously selected printer, or you can
search for and connect to a new printer, with no need to install additional
printer drivers. Because PrintWhere ties into the PrinterOn service, you can
connect and print to printers even when they are not on your local network.

The PrintWhere printing process
In Windows, PrintWhere appears as any other printer. Just like any printer, you
can click File > Print and select PrintWhere. Unlike other printers, however,
PrintWhere allows you to print to any accessible PrinterOn printer, whether on
your local network, or on a remote network.
If an administrator has not already defined a default printer for you, you’ll need
to locate and printer before you can successfully print.
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Getting started with PrintWhere

You can select a printer at any time, either from the PrintWhere Printer
Manager, or during the printing process. Once you associate PrintWhere with a
destination printer, you can submit a print job.
When you submit a print job to a printer using the PrintWhere driver,
PrintWhere renders the content and passes it on to the PrinterOn service,
which then forwards the content to the destination printer. The PrinterOn
service can be the publicly hosted service at printeron.com, which allows you
to search all PrinterOn registered printers worldwide; or it can be an onpremise version of PrinterOn Enterprise/Express, which restricts your search to
those printers within your organization.
PrintWhere monitors the print job and notifies you of changes in its status.

System requirements
PrintWhere has the following system requirements:
•

Windows 7 or later

•

2GB RAM

•

1GB free disk space (more may be required if a large number of printer
drivers are downloaded)

If you are using PrintWhere LE, in addition to the above requirements, you
must also install the necessary print drivers on your computer. PrintWhere LE
does not install any default drivers.

Downloading and installing the PrintWhere universal driver
Before you can print with PrintWhere, you need to download and install it.
•

Downloading the installer

•

Installing the PrintWhere universal driver
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Downloading the installer
You can download the installer from the PrinterOn.com website. You can install
one of two editions of the PrintWhere software:
•

PrintWhere: The full version PrintWhere, which is installed with several
generic print drivers.

•

PrintWhere LE: A light version of PrintWhere, which is installed without
any print drivers. PrintWhere LE requires that you have the print drivers
you will be using already installed on your computer. Otherwise,
PrintWhere LE is identical to the full version of PrintWhere.
Note: If you use PrintWhere LE with PrinterOn Hosted or with a hybrid
deployment of PrinterOn, the printer drivers are downloaded automatically
the first time you select a printer, if they don’t already exist on the
computer.

Installing the PrintWhere universal driver
To install the PrintWhere driver:
1. Run the installer (PWhere.exe or PrintWhereLE.exe).
2. Accept the license agreement, and complete the installation.
3. Restart the computer.

PrintWhere installed components
Once installed, the PrintWhere software includes the following components:
•

PrintWhere Printer Manager: Lets you locate and select printers
registered with PrinterOn. For more information, see Locating and
selecting printers.

•

Delivery Options dialog: Lets you to confirm the destination of your
print and review the details of your print job details. Unless you disable
it, this dialog appears every time you submit a print job. For more
information, see Confirming your print job.

•

Printer Properties dialog: Lets you configure printing options to
define the print output, PrintWhere behavior, and network
communication. For more information, see Configuring PrintWhere
printing options.
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•

PrintWhere Router: Lets you monitor and manage the status of your
print requests as they are delivered to the specified printers. For more
information, see Monitoring and managing print requests.

•

PrintWhere printer drivers: Generic printer drivers which PrintWhere
uses to communicate with the destination printer. The generic printer
drivers installed with PrintWhere can communicate with most printers.

Updating PrintWhere
To ensure that you have the latest PrintWhere features, PrintWhere alerts you
when a new version is available on our web site.
To upgrade PrintWhere:
1. When prompted by PrintWhere to upgrade, click Yes.
2. To open the PrinterOn Download page if a newer version exists, click
the Upgrade now! link.
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2
Printing with PrintWhere
You print to the PrintWhere driver using the standard Windows printing
workflow (typically, File > Print).
You can locate and choose your printer at the time of printing. If you need to
change your printer for any reason, you can locate and choose another printer
from the PrinterOn Directory at any time. The most recently used printer is
always selected by default the next time you submit a print job.
To print using the PrintWhere Printer Driver:
1. In your Windows application, select File > Print.
2. In the Print dialog, choose PrintWhere 6.0 as your printer.
3. Modify the printing preferences as necessary. The Printing Properties
dialog allows you to:
•

change your printer and view detailed printer and printer location
information

•

set paper and duplex settings

•

define PrinterOn system-specific settings and provide account
information.

4. Click Print.
5. If the Delivery Options dialog appears, confirm the delivery options,
then click OK.
Note: If you receive a release code, take care to make note of it. You may
need this code to release your print job at the printer.
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6. If necessary, provide any additional required input, such as
authentication credentials or payment information. PrintWhere
prompts you for any additional input.
Note: In some cases, PrintWhere may redirect you to a browser form to
authenticate against an Identity Management Service. You will be unable to
interact with PrintWhere while it awaits confirmation that you were
successfully authenticated.
If you fail to authenticate within a designated timeout period, the print
request fails, and PrintWhere becomes active again.
In rare cases, authentication may fail even after you receive a message
indicating you have successfully authenticated. This is typically due to a
network issue blocking a necessary second communication with the
authentication server.

7. If necessary, release the job to the printer using the release code that
was provided in the Delivery Options dialog.
Once the job is submitted, you can monitor your print job to view the status,
pause, resume, restart, or cancel it.

Confirming your print job
The Delivery Options dialog lets you to confirm the destination of your print
and review the details of your print job details. Unless you disable it, this dialog
appears every time you submit a print job. The Delivery Options dialog
displays up to three tabs:
•

Job Details: Displays information about the job, including job
summary, release information, printer information, and the selected
print options for the job. For more information, see Viewing job details.

•

Options and Info: Lets you enter information to be added to a print
job’s cover page, if enabled, and provides additional instructions or
important information supplied by the printer owner. For more
information, see Adding cover page information.

•

Cover Page Preview: Displayed only when a cover page is added to the
print job, this tab lets you preview the content of the cover page.
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Viewing job details
The Job Details tab of the Delivery Options dialog displays information about
the print job.
The job summary highlighted at the top of the tab displays the printer name,
the number of pages, the unique reference number of the print job (for
tracking purposes) and the type and name of the document. The Job Status
field indicates the progress of the job processing. Once the document is ready,
you can click OK.
Note: A Ready status does not indicate that the physical print device is operating
correctly; it indicates that the PrinterOn server can accept and hold the job prior to
releasing to the print device.
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Section

Description

Privacy Release

Displays the secure Privacy Release Code for the job.
Depending on your destination printer, you may be
prompted to enter this information before the job is
printed, or it may be generated automatically for you.

Printer Information

Displays a summary of the selected printer for the current
print request.

Job Information

Displays information about the print job and printer
settings that may affect the output of the job such as Color,
Paper Size, or Duplex options.

Adding cover page information
The Options and Info tab lets you enter information to be added to a print
job’s cover page, if enabled. It also provides additional instructions of
important information supplied by the printer owner.
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Setting

Description

Deliver To

Your name or other identification to be added to the print
job’s cover page to identify you as the owner of the print
job. This field is only enabled if a cover page is enabled for
the print job.

Comments

Comments or instructions to be added to the cover page.
This field is only enabled if a cover page is enabled for the
print job.

Instructions

Instructions supplied by the printer owner for users. For
example, the printer owner may provide details about when
a document can be picked up or how it can be delivered.

Monitoring and managing print requests
The PrintWhere Router window lets you monitor and manage the status of
your print requests as they are delivered to the specified printers. The Router
displays information about the type and size of the document sent, the printer
it is being sent to after being released from the server, and the portion of the
print request that has already been sent.

Note: If you shut down your computer or close the PrintWhere Router while it is
sending documents, the unfinished jobs will resume automatically when you restart
your computer or open the Router.
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To monitor your print jobs:
1. Double-click on the

icon in your system tray.

Note: If the icon is not visible, you can launch the PrintWhere Router by
double-clicking the PWRouter.exe in the PrintWhere Program Files
directory.

The PrintWhere Router appears, displaying the following information
for each active print request:
Column

Description

Document
Name

The name of the document being transmitted. You can
hide the names of your documents and replace the
name in the router with the PrinterOn Transaction ID
(see figure).

Status

The current delivery status of the job.

% Sent

The amount of data delivered to date.

Pages

The number of pages included in the print job.

Size

The size of the entire document (for example, 500KB).

Submitted

The date and time that the print request is made.

Destination

The PrinterOn ID of the destination printer (for
example corp-acme-accounting).

Printer Model

The manufacturer's brand name for the printer (for
example, HP LaserJet 2100).

Transaction ID

A unique identifier for the print request.
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2. If necessary, select a print job, then open the Document menu and
perform one of the following actions:.
Action

Description

Pause

Makes a print request ineligible for printing. You can pause
print requests with the following status:
•

Pending: The status changes to Paused, and the
request is not sent to the printer until it is resumed or
restarted.

•

Printing: The status changes to Printing–Paused.

•

Printing–restarting: The status changes to Printing–
Pausing.

The router cannot pause a printing job if all the data has
been transmitted.
Resume

Makes a paused print request eligible for printing. The
print request status changes from Paused or Printing–
Pausing to Pending. The print request is then eligible for
printing, but may not be the next job printed.

Restart

Stops a print request with a status of Printing and restarts
it. The function can only stop the print request if all the
data has not already been transmitted. The print request
returns to the Pending state. It may not be the next job
printed.

Cancel

Deletes the selected print request from the PrintWhere
Router. You can cancel print requests with the following
status:
•

Paused

•

Pending

•

Printing

•

Printing–Pausing.

If the router shows that the entire document has been sent,
you cannot cancel the print job.
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3
Locating and selecting printers
PrintWhere includes a Printer Manager application to help you search for,
locate, and select a printer.
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Locating and selecting printers

You can access the Printer Manager in a number of ways:
•

Clicking Start > PrintWhere Printer Manager.

•

Clicking

•

Double-clicking the desktop icon.

•

Clicking Find a Printer from the PrintWhere Printer Preferences
dialog, which you can access from any Windows Print dialog.

in the system tray.

Discovering and selecting printers
To locate and select a printer:
1. In the PrintWhere Printer Manager window, find a printer by
•

Performing a basic keyword search, which lets you search for a
printer name or organization name, for example.

•

Performing an advanced search, which lets you provide additional
criteria to further limit the number of printers returned.

•

Clicking the History tab and choosing a previously selected printer
from the list.

2. When you find the printer you want, select it, then click OK. The
Confirm Printer Selection dialog appears.

Note: Click Details to get additional information about the printer.
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3. Once the Printer Status changes to Destination Ready, click Select.
PrintWhere updates your printer selection. The printer is also added to the
History list. This printer will be used by default next time you print from your
applications.

Performing a basic keyword search
A basic keyword search lets you search the PrinterOn Directory based on one
or more keywords you provide.
Note: You can limit the number of search results that are returned by configuring
search filters in the Search Preferences dialog. For example, if you provide an
organization name, results are filtered to include only those printers that are
registered to that organization. Search preferences are applied to every basic
keyword search.
For more information, see Configuring printer search filters.

To perform a keyword search:
1. Enter one or more keywords in the Keywords field.

Note: If you are using PrinterOn Enterprise/Express, you can return all
available printers by leaving the Keywords field empty.

2. If you want to limit the search results to printers that require your
authentication credentials, check Private Printers Only.
Note: If you check Private Printers Only, you must specify your access
credentials in the Search Preferences for the Printer Manager to return any
results. For more information, see Accessing secured printers.

3. Click Search. The Printer Manager queries the PrinterOn directory and
displays results in the Search Results tab.
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Performing an advanced search
The Advanced Search dialog lets you be more specific about your search
criteria, so that you can restrict which printers are returned in your search
results.
Note: An advanced search ignores any preferences that you have specified in the
Search Preferences dialog.

To perform an advanced search.
1. In the PrintWhere Printer Manager, click Advanced. The Advanced
Search dialog appears.

2. Use the Category selection to limit the type of printers to include in a
search request. Options include:
Category Type

Description

All

Any printer in the PrinterOn Directory.

Public

Printers that are available to the general public.

Organization

Printers that are part of a PrinterOn Enterprise or
PrinterOn Business service.
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3. Select which printing features you want your destination printer to
have.
Feature

Description

Paper

The paper size you want to print to.

Duplex

The duplex option you want to use.

Privacy

Whether the printer should require you to enter a
release code before the job is printed.

Color

Whether the printer should support color or only Black
and White.

4. Enter search criteria that will be used to filter search results based on
the information supplied.
Criteria

Description

Keywords

One or more descriptive words to search for.

Organization

The name of an organization or company, as
configured in the PrinterOn Directory, that the printer
must belong to.

City

The city name where the printer must be located.

State

The state or province where the printer must be
located.

Country

The country in which the printer must be located.

Private Printers
Only

When checked, search results only include printers
that have control access, and are accessible using the
Account Information supplied in the Search
Preferences dialog.
For more information on specifying account
information, see Accessing secured printers.

Managing printer lists
The Printer Manager lets you:
•

specify how to sort printers in the History and Search Results printer
lists.

•

clear the History list.
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Sorting printers
For the printers listed in the History and Search tabs, you can sort your printers
in a number of ways.
To sort printers:
1. From the Order By drop-down, choose how printers are sorted:
Setting

Description

Most Recently
Used

Displays the printers in the History tab in the order
they were used. This is the default.

Organization

Lists the printers alphabetically according to the name
of the organization that owns the printer.

Printer Name

Lists the printers alphabetically according to the name
of the printer.

Price

Lists the printers according to the cost of printing,
from lowest to highest. Free printers are listed first.

Allowed Pages

Lists the printers according to the number of pages
you are allowed to print. If no number is present,
there is no limit.

Clearing the History list
The History tab displays a list of printers that you have previously selected. You
can clear this list of all printers.
To clear the History list.
1. In the PrintWhere Printer Manager, click Search Preferences.
2. In the PrintWhere Search Preferences dialog, click Clear History.
3. On the Confirmation dialog, click OK.
4. Click OK.
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Setting printer search preferences
Clicking Search Preferences in the Printer Manager displays the Search
Preferences dialog.

This dialog lets you manage various search settings. From this dialog, you can:
•

Define search filter criteria.

•

Specify a different service URL to search a private printer directory.

Configuring printer search filters
Because the PrinterOn Directory contains every printer registered with
PrinterOn, certain keywords may yield a very large number of printers. To
restrict search results without performing an advanced search every time, the
Search Preferences dialog lets you configure some basic filters to narrow the
list of search results to a more manageable number.
For example, to restrict the results to your organization, you can provide the
organization name. In a multinational organization, you could further restrict
results to a particular geographic location. The information you supply in
PrintWhere is compared to the information that was configured by the printer
owner or administrator.
Filter settings are applied to every basic keyword search. You can override the
filter settings by performing an advanced search.
To set printer search filters:
1. In the PrintWhere Printer Manager window, click Search Preferences.
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2. In the Search Using section of the Search Preferences dialog, define
your filter criteria:
Filter

Description

Organization

The name of a company, as provided in the Printer
Listings.

Address

Any part of address information (state, city, street, zip
code, etc.) that you provided in your Printer Listings

Category

The type of PrinterOn printer to filter. Options include
All printers, PrinterOn Public printers and printers
within your Organization. Organization printers include
PrinterOn Business or PrinterOn Enterprise printers

Accessing secured printers
If you have permission to use secured printers, you must provide the necessary
service URL and account information to allow PrintWhere to search for and
access them. A secured printer might be:
• a private printer within an enterprise that is only accessible to users
within the firewall
•

a public printer with restricted access, such as a printer at a hotel that is
available only to hotel guests

Note: If PrintWhere was configured for you by an administrator, it may not be
possible to change your Service URL or account information without their
assistance.

Setting a custom service URL
The Service URL identifies the address of the PrinterOn service that hosts the
PrinterOn Directory of printers, which PrintWhere searches to locate printers
that match your criteria.
By default, PrintWhere searches the public directory hosted at printeron.com,
which contains all registered PrinterOn printers worldwide. However,
organizations with an on-premise solution, such as PrinterOn Enterprise or
PrinterOn Express, maintain a private directory of their own printers.
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If your organization has an on-premise installation, this value must be explicitly
set and must match the Service URL that the PrinterOn Server uses so you can
search your private PrinterOn Directory for your organization’s printers. An
administrator may have pre-defined this value for you. If it has not already
been set, you must manually configure this value yourself.
When configured, PrintWhere will use the Service URL for all communication
with the PrinterOn server, including:
•

Searching for printers

•

Delivering print jobs to destination printers

•

Reporting and logging

•

Retrieving printer configuration information

If you need to locate a public printer (for example, if you are traveling and need
to use a hotel printer), you can clear your private Service URL and access the
public PrinterOn Directory to search for and locate the printer at your hotel.
You must make sure you reconfigure your private Service URL when you’re
back on your organization’s network.
Note: Only printers that are associated with the currently specified Service URL are
accessible. If you select a printer from the public Service URL, then change to a
private Service URL, you can no longer print to the printer associated with the
public Service URL.

To set a custom URL to support an on-premise version of PrinterOn:
1. In the PrintWhere Printer Manager window, click Search Preferences.

2. In the Service URL section of the Search Preferences dialog, enter the
host name or IP address of the server hosting your PrinterOn service.
3. Click OK.
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Providing account information
Use of some printers may be restricted. Depending on the how access to the
printer is configured, different account information may be required:
•

In some print workflows, you may be required to supply your Windows
account information to submit a print job. PrintWhere automatically
extracts your username and includes this information with print jobs
when required. The System Login ID value indicates the operating
system defined login identifier for jobs.

•

Some workflows may be configured to use a corporate LDAP/AD
server or some other Identity Management Service for access control.
In this case, you must provide the credentials for that server/service.
You can provide your account information in the Account Settings
dialog, and PrintWhere will pass those credentials to the authentication
service on your behalf.

Note: If you are using PrinterOn Enterprise or PrinterOn Express, you must enter
the PrinterOn Server’s Service URL before you provide your user credentials. When
you provide user credentials, PrintWhere immediately tries to contact the PrinterOn
Server to validate them. Without the Service URL, PrintWhere can’t contact the
server and validation fails.

To provide your user credentials:
1. In the PrintWhere Printer Manager window, click Account Settings. The
Account Settings dialog appears.

2. Under Account Settings, click Edit. The Account Credentials dialog
appears.
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3. Enter your Username and Password.
4. Click OK.
5. To make sure you entered your account information correctly, click
Validate to validate your credentials against the server.
Note: If you are using PrintWhere in a public environment, such as a kiosk,
you should clear your User Information at the end of your session. For more
information, see Clearing the current account information.

6. Click OK to close the Account Settings.

Clearing the current account information
If you are using PrintWhere in a public environment, such as a kiosk, you
should clear your account information at the end of your session.
1. In the PrintWhere Printer Manager window, click Account Settings.
2. In the Account Settings dialog, click Clear Credentials.
3. Click OK to return to the PrintWhere Printer Manager.
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Configuring PrintWhere printing
options
PrintWhere lets you configure a number of printing options to define the print
output, PrintWhere behavior, and network communication.
To configure PrintWhere printing options:
1. Open the PrintWhere Printing Properties dialog:
•

In the Windows Printers folder, right-click PrintWhere <version>
and select Printing Preferences.

•

From the application's Print window, select PrintWhere <version>
as your printer, then click the Preferences or Printer Properties
button.
Note: When using the Chrome browser, you must select Print using
system dialog to be able to access the Printing Properties.
Note: When choosing PrintWhere as your printer, make sure you choose
PrintWhere <version>. Do not choose PrintWhere <version> Plug-in nnnn.
This plug-in is merely an artifact PrintWhere creates to contain the specific
printer driver required for a previously selected printer.

25
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2. Configure the settings on the following tabs:
•

Printer: Specifies the destination printer and printer details. You can
also change the destination printer from this tab.

•

Paper: Specifies a number of basic page setup options.

•

Options: Specifies additional PrintWhere settings or network
communication settings.

3. Click OK.

Viewing printer information
The Printer tab provides information about the printer you are sending your
document to. This tab also lets you select a previous printer, or access the
Printer Manager to choose a new printer.
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Setting

Description

Printer

Specifies the destination printer. To change the printer:
•

Manually enter the PrinterOn ID or Printer Number.

•

Select a recently used printer from the drop-down list.

•

Click Find a Printer to open the Printer Manager and
search for a printer in the Directory. For more
information, see Locating and selecting printers.

Status

Indicates whether the printer is Online and ready to be
used, or Offline for maintenance.

Connection

Indicates whether the printer is located on the Internet or
on a local network.

Company

The name of the company who owns the printer, as
described by the administrator in the printer's Directory
listing.

Vicinity

The specific location of the printer, such as 'Front Desk' or
'Accounting department'.

Description

A brief description of the printer, provided by the printer
administrator. The description may explain what kind of
printer it is, how the printer can be accessed, or how should
be used. For example, the description might read Color
laser or Release Code required for document pick up.

Options

Describes any restrictions on printing, such as the maximum
number of pages, or whether color printing is permitted.

Model

The manufacturer, make and model of the printer.

Details

When clicked, opens the Printer Details window, which
provides a complete description of the printer as provided
by the printer owner. This additional information may
include such information as duplexing options or pricing
information.
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Configuring paper settings
The Paper tab lets you specify a number of basic page setup options.

To modify the PrintWhere options:
1. In the PrintWhere Properties dialog, click the Paper tab.
2. From the Size drop-down, choose the size of the paper you want to
print to.
Note: The owner of the printer specifies which paper sizes are supported.
If the printer owner has not specified any paper sizes, the default is Letter
(8 1/2 x 11 in).
Your paper size choices are limited to this list as dictated by the printer
owner. Although the Advanced properties dialog may offer additional
paper sizes, if those additional paper sizes are not enabled by the printer
owner, PrintWhere cannot print to them.

3. Specify whether to print the document in Landscape or Portrait
orientation.
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Configuring PrintWhere printing options

4. If enabled, choose a duplex option. Choices vary depending on which
options the printer owner configured for the printer. Duplex options
can include:
•

Single Sided Only (Simplex)

•

Double Sided Only (Duplex)

•

Default to Single Sided: When duplex is also available, but is not
selected.

•

Default to Double Sided: When simplex is also available, but is not
selected.

•

Not Managed: The printer owner has placed no restrictions on the
Duplex feature. Depending on the printer, duplexing may be still
available in the Advanced printer driver properties.

5. Specify whether you want to print in color or in black and white.
6. To modify other available printer driver properties, click Advanced.
Depending on the print data generator associated with the printer,
various additional options may be available.
Note: In some cases, the PrintWhere Paper settings may override similar
printer driver properties.

Configuring the Options tab
From the Options tab, you can:
•

configure PrintWhere workflow and behavior.

•

configure network communication settings.

•

change your account information.

Setting PrintWhere workflow and behavior
PrintWhere provides a number of options that allow you to customize your
print workflow or to provide compatibility with certain printers. These options
do not generally need to be modified.
To modify the PrintWhere options:
1. In the PrintWhere Properties dialog, click the Options tab.
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Configuring PrintWhere printing options

2. Click the PrintWhere Settings button. The PrintWhere settings dialog
appears.

Settings are organized into three sections:
Section

Description

Print Confirmation
Dialog

Define the behavior of the confirmation dialog that
displayed by PrintWhere during the print process.

Processing Settings

Define the behavior of PrintWhere when
configuring or processing print jobs.

General Settings

Define general PrintWhere behavior.

3. Configure the settings as necessary, then click OK.

Print Confirmation Dialog settings
The following settings affect the behavior of the confirmation dialog presented
by PrintWhere during the print process.
Setting

Description

Only Display When
Required

When enabled, the Print Confirmation dialog only appears
if user input is required.
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Configuring PrintWhere printing options

Setting

Description

Enable Privacy
Release
Confirmation

When enabled, a reminder message appears when the
printer requires a release code to access a print job. The
prompt is displayed after accepting and closing the
confirmation dialog.

Allow nonPrinterOn Drivers

When enabled, PrintWhere searches the local PC for a
compatible print driver before downloading components
from the PrinterOn web services.
PrintWhere is capable of downloading additional driver
components to support a particular printer. When you
select a new printer, PrintWhere can check whether the print
driver is already installed on the PC.

Job Processing Settings
The following settings affect the behavior of PrintWhere when configuring or
processing print jobs.
Settings

Description

Enable Plugin
Caching

When Enable Plugin Caching is enabled, PrintWhere
maintains multiple PrintWhere printer plugins.
You cannot change this setting. If necessary, an
administrator can update the registry to enable plugin
caching. For more information, see Enabling plugin caching.

Use Alternate
Duplex

When enabled, PrintWhere uses alternate duplex options.
In many environments, PrintWhere informs the printer
whether to print a print job as duplex and uses the most
compatible solution to provide duplex options. If you
encounter problems receiving duplex output, you can try
the alternate duplex options.
This option should only be changed if you are encountering
problems printing.
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Configuring PrintWhere printing options

Settings

Description

Disable Color
Setting Override

By default, PrintWhere attempts to override the color
settings for printers to obey the values entered by the
printer owner. If you encounter problems printing B&W
output to a color printer or vice-versa, disabling this option
may improve output.
This option should only be changed if you are encountering
problems printing.

General Settings
The following settings affect the overall behavior of PrintWhere when printing.
Setting

Description

Hide Document
Name

When enabled, the name of the document is replaced by
the unique reference number for the print request.

Enable Kiosk Mode

When enabled, PrintWhere doesn’t store user or account
information entered by the user. This is recommended when
deploying PrintWhere in a public location or kiosk.

Anonymous Job
Reporting

When enabled, PrintWhere removes all user identifying
information that may be reported to PrinterOn. Information
included in reports to PrinterOn is typically used to provide
auditing or tracking services for the printer owner.

Minimal Job Data
Reporting

When enabled, PrintWhere removes document related
information sent to PrinterOn. This includes information
such as file sizes and file extensions.
Note: The information supplied when this option is not
enabled is used for analytic purposes only.

Configuring SSL and proxy server settings
If your environment requires the use of a proxy server or self-signed
certificates for facilitating secure communication, you may need to configure
network settings so that PrintWhere can successfully deliver print jobs to the
printer.
To configure network settings:
1. In the PrintWhere Properties dialog, click the Options tab.
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Configuring PrintWhere printing options

2. Click the Network Settings button. The Network Settings dialog
appears.

3. To enable PrintWhere to communicate with services that use selfsigned certificates for HTTPS communication, check Disable SSL
Certificate.
4. If your PrinterOn configuration uses a proxy server, check Enable
Proxy, then configure the following proxy server settings:
Setting

Description

Proxy Server

The proxy server address used by PrintWhere. Include
the server IP/address and the port number in this
field (for example, 192.168.1.1:800).

Windows NTLM

When checked, PrintWhere uses NTLM for proxy
authentication. Otherwise, PrintWhere uses Basic
proxy authentication.

User Name

The login/username to use when authenticating
against the proxy server.

Password

The password to use when authenticating against the
proxy server.

5. Click OK.
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A
Glossary of terms
Cover Page
An option set by the printer owner that determines whether or not the user will
be required to print a cover page. By default, cover pages include: the printer
address, the sender's name, the reference number of the print request, and the
number of pages. Users can add the recipient name and additional comments
when they send their documents.

Encryption
Encryption is the translation of data into a secret code. Encryption is the most
effective way to achieve data security. To read an encrypted file, you must have
access to a secret key or password that enables you to decrypt it.
PrinterOn uses public-key, or asymmetric, encryption, a cryptographic system
that uses two keys: a public key, known to everyone; and a private or secret key,
known only to the recipient of the message. When John wants to send a secure
message to Jane, he uses Jane's public key to encrypt the message. Jane then
uses her private key to decrypt it.
An important element of the public key system is that only the public key can
be used to encrypt messages and only the corresponding private key can be
used to decrypt them. Moreover, it is virtually impossible to deduce the private
key if you know the public key. Public-key systems are becoming popular for
transmitting information via the Internet. They are extremely secure and
relatively simple to use.
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The setting is also determined by whether the printer owner has attached the
printer to a Print Delivery Station server and how the encryption setting in the
server is configured. If the printer or server at the other end of the transmission
does not support our encryption service, the print request will be sent
unencrypted.
When you confirm your print job prior to printing, the Job Information tab
describes he encryption setting, which will use one of the following labels:
None, Not supported by destination, Enable.

Internet Protocol
Internet Protocol (IP) specifies the format of packets, also called datagrams,
and the addressing scheme. Most networks combine IP with a higher-level
protocol called Transport Control Protocol (TCP) which establishes a virtual
connection between a destination and a source.

IP Address
This is the unique Internet Protocol address for a device on the Internet,
identifying the network and device transmitting the information. Usually
expressed as four decimal numbers, IP addresses can either be static, or
randomly assigned from one session to the next.

IPP/Internet Printing
The Internet Print Protocol (IPP) is a sanctioned Internet Engineering Task Force
(IETF) standard for printing documents over the web. IPP defines basic
handshaking and communication methods, but does not enforce the format of
the print data stream. Typically, a standard page description language, such as
HP PCL or Adobe PostScript, would be used.

Printer Number
A Printer Number is a unique 12 digit number people can use to find your
printer in the PrinterOn Directory. Every printer added to the PrinterOn
Directory is given a Printer Number to make it easy for people using mobile
devices, such as cellular phones or tablets, to find and use a printer. A Printer
number follows the format: ###-###-###-### or ############.
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PrinterOn ID
A unique, logical printer address that will be used to access the printer in the
Printer Directory from PrinterOn products and services. The PrinterOn ID is a
fixed address that is used to identify the printer, enabling you to change the
physical location, or even the make and model of your printer.

Privacy Settings
A description in the PrintWhere Job Information tab that explains how the print
job will be released to the user. The printer may be operated by an attendant,
the print job may be released automatically, or the print job may require the
user to enter information to release the print job.

Service URL
The Service URL is the location of your PrinterOn service. PrintWhere connects
to this URL to access the PrinterOn directory. The Service URL also manages all
printing communication; PrintWhere submits print jobs to the PrinterOn
service URL, which then forwards the job to the destination printer.
By default, PrintWhere points to the Service URL for PrinterOn Hosted, which is
publicly available to all PrinterOn users. You may need to change the Service
URL the PrintWhere connects to, however. If your organization hosts its own
PrinterOn Enterprise or PrinterOn Express solution, you should modify the URL
to point to your private PrinterOn service.

URI
Uniform Resource Identifier, the generic term for all types of names and
addresses that refer to objects on the World Wide Web. A URL is one kind of
URI.
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B
Configuring PrintWhere for Citrix or
shared terminal environments
Administrators can deploy PrinterOn in environments where multiple users are
accessing printing services through a single server or terminal. For example:
•

Citrix environments: In these environments, a central Citrix server is
used to provide employees with remote access to network printers no
matter where they may be: at the office; at home; or at a public
printing location, such as an airport or library

•

Shared terminal environments: In these environments (for example, a
public printing kiosk), a single computer is used to access printing
services, but each user logs in under their own account.

In each of these cases, installing and configuring the PrintWhere software to
access the printing infrastructure is essentially the same.

Using PrinterOn with Citrix
PrinterOn can be used with Citrix in a couple of scenarios:
•

In mobile environments, where the Citrix Receiver mobile app is used
to access a server-based desktop environment, PrinterOn’s network
infrastructure can be used to deliver the print data across disparate
networks. PrinterOn’s PrintWhere driver is used to deliver print data
from the Citrix server to the remote print location.
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•

On Windows desktop computers, PrintWhere provides native File >
Print capability from any application. Typically, Citrix users are only able
to print to the printers directly connected to the Citrix server. Through
PrintWhere, users are able to search for and print to all enabled
enterprise printers without being connected to the network or having
particular print drivers installed. This gives employees remote access to
enterprise printers no matter where they may be.

To enable printing from Citrix, administrators must enable employees to access
PrintWhere from their Citrix sessions. This appendix describes how to provide
users with the access they need.

Citrix server configuration
The PrinterOn PrintWhere driver requires the following software:
•

Citrix XenApp 6.5 or later

•

Windows 2008 r2 x64 or later

•

Windows 2012 r2 x64 or later

The server is part of a workgroup. PrinterOn services must be installed on a
single server. PrintWhere is installed for multiple users on the farm node.
In addition, to allow users to access the PrintWhere documentation, you should
ensure that the Microsoft XPS Viewer is installed on your server.

Installing PrintWhere in your environment
To install PrintWhere:
1. Download the PrintWhere installer from the PrinterOn website at
www.printeron.com/support/downloads.html.
2. On the farm node, click on Start > All Programs > Accessories.
3. In the Accessories folder, right-click on Command Prompt, and select
Run as administrator.
4. In the Administrator: Command Prompt window, type:
change user /install.

5. From the command prompt, type PWhere.exe to launch the
PrintWhere installer.
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6. Follow the installation instructions.

Configuring the central computer to use PrintWhere
To avoid issues and ensure that users can print, administrators should preinstall necessary printer drivers on the computer. An administrator should
install, configure, and print to each device prior enabling users. After the
administrator has printed once, subsequent users can use the service without
additional rights.

Configuring the user’s computers
To ensure that users avoid issues using PrintWhere, administrators must
modify the Windows Registry on the shared terminal accessed by users, or in a
Citrix environment, on each user’s computer locally, to complete the following
tasks:
•

Enable plugin caching

•

Suppress Interactive Service Messages

In addition, if you intend to create and use a ExternalConfig.xml file to
configure PrintWhere settings for users, the XML file must be added to every
user’s account, even when those users are using the same shared terminal.
For more information about creating an external configuration file, see
Creating an XML configuration file.

Enabling plugin caching
With PrintWhere, when a user changes a destination printer, PrintWhere adds a
helper printer object to the computer, referred to as a PrintWhere plugin. This
plugin provides the computer access to the required printer driver. By default,
to minimize its presence on the computer, PrintWhere uses only one plugin at
a time. Whenever a user selects a different printer, PrintWhere removes the
existing plugin and adds a new one.
To make these changes to the system, PrintWhere requires the user to have
permission to change printers and set the drivers. If the user does not have
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permission to install drivers, then errors occur which can prevent the user from
printing.
Plugin caching allows PrintWhere to maintain multiple plugins so that they
don’t need to be removed and added every time the user selects a different
printer. This approach allows users who cannot add new printers to work
around their limited permissions. Users can move between the printers
previously configured by the Administrator, since, from the system’s
perspective, PrintWhere remains the selected destination printer.
Note: A user with administrator privileges MUST install the necessary drivers prior
to providing the service to users with less privileges. For more information, see
Configuring the central computer to use PrintWhere.

To enable plugin caching:
1. Open the Windows Registry Editor and navigate to the following
Registry location:
HKEY_LOCAL_MACHINE\Software\PrinterOn
Corporation\PrintWhere <version>
2. In the right pane of the registry window, right-click and select New >
DWORD value. The new value is added to the registry, with the name
editable.
3. Change the value name to PluginCacheEnabled.
4. Right-click PluginCacheEnabled and click Modify. The Edit DWORD
Value dialog appears.

5. Set the Value data to 1.
6. Close the Registry Editor.
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Suppressing Interactive Service Messages
Because PrintWhere plugins appear as a selectable printers, users can
accidentally submit print jobs to a plugin instead of to the PrintWhere driver
itself. When this happens, PrintWhere attempts to display a message informing
the user that the selected plugin is not a valid selection, and to choose the
PrintWhere driver instead.
In rare cases, the print process uses system services, such as the print spooler,
to display these messages. In cases where users do not have sufficient
permissions to see these Interactive Service Messages, such as in Citrix
environments, the user may not see the messages, and printing problems can
occur. To avoid issues, administrators can disable Interactive Service Messages.
To disable Interactive Service Messages:
1. Open the Windows Registry Editor and navigate to the following
Registry location:
HKEY_LOCAL_MACHINE\Software\PrinterOn
Corporation\PrintWhere <version>
2. In the right pane of the registry window, right-click and select New >
DWORD value. The new value is added to the registry, with the name
editable.
3. Change the value name to SuppressISM.
4. Right-click SuppressISM and click Modify. The Edit DWORD Value
dialog appears.

5. Set the Value data to 1.
6. Close the Registry Editor.
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C
Installing and configuring PrintWhere
for users
To simplify the setup process for users, PrintWhere provides methods to allow
administrators to install and configure PrintWhere on users’ behalf using
command line installation and an external configuration.

Configuring PrintWhere for users
With external configuration, administrators can pre-define printer lists for
users, preset search filters, set the service URL where PrintWhere searches for
printers, and configure other settings. The first time PrintWhere is started, the
options from the external configuration are loaded, so users can print with no
setup at all.
External configuration of PrintWhere also allows administrators to centrally
manage PrintWhere behavior and provide a consistent experience for all users.
There are two methods to allow administrators to configure PrintWhere for
users:
•

Creating an XML configuration file

•

Creating a PrintWhere Windows Registry key

When PrintWhere is configured for them, users can still access the PrintWhere
Printer Manager and Printer Properties dialogs. If users change the PrintWhere
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configuration, PrintWhere checks to see if an XML configuration file or
PrintWhere registry key exists, and if so, saves any changes made by the user to
the external configuration.
Administrators can also lock the PrintWhere configuration, so that users
cannot change it at all.

Creating an XML configuration file
You can create an XML configuration file for PrintWhere that you can distribute
to users.
The XML file must be named ExternalConfig.xml, and it must be copied to the
following location on the user’s computer:
C:\Users\<user_name>\AppData\Local\PrinterOn
Corporation\Printwhere <version>\Config\ExternalConfig.xml

External XML Example
The following sample XML shows the structure of the XML configuration file.
For details about each of the settings, see External configuration settings
reference.
<pwcProperties propertiesVersion="1.0">
<search enabled="1">
<searchOrgName userEdit="1"/>
<searchAddress userEdit="1"/>
<siteNumberList use="optional"/>
</search>
<printerChooser sysTrayAndStartup="1" userEdit="1"/>
<webServiceManagerURI/>
<DefaultPrinterList/>
<lockPrinterConfig>0</lockPrinterConfig>
<AuthenticationMode>0</AuthenticationMode>
<AskForCredentialsAlways>0</AskForCredentialsAlways>
<OAuthBrowserTimeout>120</OAuthBrowserTimeout>
<serviceURL>secure1.printeron.net</serviceURL>
<removePrinters>0</removePrinters>
<siteID/>
<clientUID/>
<sessionMetaData/>
<OptionShowWinPrinters>1</OptionShowWinPrinters>
<SearchUsingPrivateURL>1</SearchUsingPrivateURL>
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<SearchCategory>All</SearchCategory>
<PrimarySite>www.printeron.com</PrimarySite>
</pwcProperties>

Creating a PrintWhere Windows Registry key
Registry configuration can be managed for individual users using their
standard Windows user profile locations.
The PrintWhere Registry configuration information should be put into the
users Current User registry hive, at the following location:
HKEY_CURRENT_USER\Software\PrinterOn Corporation\PrintWhere
<version>\ExternalConfig

Sample Registry
The following sample the structure of the PrintWhere configuration in the
Windows registry. For details about each of the settings, see External
configuration settings reference.

PrinterOn PrintWhere v6.0.1 User and Administrator Guide

|

44

External configuration priority
PrintWhere external configuration can be used alongside the Control Panel
configuration options. However, only one external configuration method can
be used at a time. You cannot use an XML configuration and Registry
configuration at the same time.
Each time PrintWhere is launched, it checks to see if an external configuration
exists, and if found, loads the specified configuration settings. PrintWhere first
checks to see if ExternalConfig.xml exists. If the file is not found, it then checks
for a PrintWhere entry in the Windows registry.

Upgrading an external configuration
PrintWhere supports external configuration upgrade. Older versions of
PrintWhere will also be migrated from previous configuration locations in the
registry to the new XML file format to support a forward migration to the new
method.
If no external configuration exists, PrintWhere uses default values.

External configuration settings reference
The following sections outline the external configuration settings and
permitted values.
•

AskForCredentialsAlways

•

AuthenticationMode

•

DefaultPrinter

•

LockPrinterConfig

•

OAuthBrowserTimeout

•

PrimarySite

•

PrinterChooser

•

RemovePrinters

•

Search settings

•

ServiceURL

•

Third-party integration settings
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AskForCredentialsAlways
Description

Specifies whether the user must provide their credentials each time they
close or minimize the Printer chooser.

XML Syntax

<AskForCredentialsAlways>
value
</AskForCredentialsAlways>

Registry Entry
Values

AskForCredentialsAlways value
value can be one of:
0: PrinterOn asks for credentials once, and then saves them. PrinterOn does
not ask for credentials again.
1: When the user logs off, PrintWhere clears credentials. The next time they
print or access Printer Manager, PrintWhere prompts the user for their
credentials. This value only applies with AuthenticationMode is set to a
value of 2 or 3.

AuthenticationMode
Description

Specifies the authentication mode used.

XML Syntax

<AuthenticationMode>
value
</AuthenticationMode>

Registry Entry
Values

AuthenticationMode value
value can be one of:
0: PrintWhere does not prompt the user for their credentials, but passes on
the credentials specified PrintWhere’s Account Settings dialog, when
required.
If the user does not provide their credentials in the Account Settings
dialog, but the PrinterOn server is configured to use either LDAP/AD or
Azure AD for authentication, the user will not be authenticated and all
print requests are rejected.
1: Windows authentication is used (either the local user account, or the
administrator credentials, if logged in as administrator).
2: The LDAP/AD or Azure AD account credentials are used.
3: Only the PrinterOn account username is used.
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DefaultPrinter
Description

Specifies a list of Default Printers. The first member of the list will be the
default selected one when you use the PrinterChooser. Additional printers
listed will be available from the Printer drop-down list in the PrintWhere
Properties dialog.
Printers are displayed in the Printer Manager’s History list in the order they
are listed.

XML Syntax

Registry Entry

<DefaultPrinterList>
<DefaultPrinter>printer1</DefaultPrinter>
<DefaultPrinter>printer2</DefaultPrinter>
</DefaultPrinterList>
DefaultPrinter printer1,printer2,...
Note: Multiple printers can be defined in a comma-separated list.

Values

printer represents the PrinterOn printer name or printer number.

LockPrinterConfig
Description

Specifies whether the printer configuration can be modified by users.

XML Syntax

<lockPrinterConfig>
value
</lockPrinterConfig>

Registry Entry
Values

LockPrinterConfig value
value can be one of:
0: The user can modify the printer configuration.
1: The Printer configuration is locked and cannot be modified.
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OAuthBrowserTimeout
Description

Specifies the length of time PrintWhere waits for the user to authenticate
against an external third-party authentication service, such as Microsoft
Azure AD.
These services require PrintWhere to redirect the user to a URL hosted by the
service to enter their credentials, during which time PrintWhere remains
blocked. Because PrintWhere has no control over the browser session, the
timeout value allows you to provide a finite amount of time before
PrintWhere assumes the user did not successfully authenticate.
If PrintWhere does not receive a response that the user is successfully
authenticated before the timeout, the user is informed that PrintWhere
could not validate the account, and PrintWhere becomes unblocked.
The default timeout is two minutes.

XML Syntax

Registry Entries
Values

<OAuthBrowserTimeout>
integer
</OAuthBrowserTimeout>
OAuthBrowserTimeout value
integer is the length of time, in seconds before PrintWhere aborts the
authentication process.

PrimarySite
Description

Specifies the site where the PrinterOn license is accessed. This site is also
used for PrintWhere downloads. This is not the same as the Service URL.

XML Syntax

<PrimarySite>
string
</PrimarySite>

Registry Entry
Values

PrimarySite string
string is the URL of the primary site.
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PrinterChooser
Description

XML Syntax

Registry Entries
Values

Specify printer chooser settings. You can specify:
•

whether PrintWhere Printer Manager icon is minimized to the system
tray when closed.

•

whether the user can edit the settings in the printer chooser.

<printerChooser
sysTrayAndStartup=”sys_value”
userEdit=”edit_value”/>
PrinterChooser_SysTrayAndStartup sys_value
PrinterChooser_UserEdit edit_value
sys_value can be one of:
0: The Printer Manager is not minimized to the System Tray.
1: The Printer Manager is minimized to the System Tray.
edit_value can be one of:
0: The user cannot edit the settings.
1: The user can edit the settings.

RemovePrinters
Description

Clears the list of previously selected printers whenever a new Service URL is
pushed to the user.
This setting does not affect behavior when the user changes the Service URL
manually in Printer Manager.

XML Syntax

Registry Entry
Values

<RemovePrinters>
value
</RemovePrinters>
RemovePrinters value
value can be one of:
0: The printer list is not modified. Printers are not removed.
1: The printer list is cleared. This is the default.
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Search settings
Description

Specify whether the user is permitted to search for printers, and defines
address, category, and organization search filters. If searching is permitted
and filters are defined, PrintWhere only returns printers that are located at
the specified address, match the specified category, or belong to the
specified organization.
You can also specify whether the user is permitted to edit the Search Address
or Search Organization value.

XML Syntax

Registry Entries

Values

<search enabled=”1”>
<searchAddress userEdit=”value”>
addr_string
</searchAddress>
<searchCategory>
cat_string
</searchCategory>
<searchOrganization userEdit=”value”>
org_string
</searchOrganization>
</search>
SearchAddress addr_string
SearchAddress_UserEdit value
SearchCategory cat_string
SearchOrgName org_string
SearchOrgName_UserEdit value
addr_string represents any part of an address (state, city, street, zip) defined
for a printer.
cat_string is one of the following categories:
•

All

•

Public

•

Organization

org_string represents a company name defined for a printer.
value can be one of:
0: The user cannot edit the filter value.
1: The user can edit the filter value.
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ServiceURL
Description

Specifies the Service URL, which identifies where the PrinterOn Service is
hosted. This URL hosts the printer list that PrintWhere searches.
If you specify a Service URL value that points to a service that requires
credentials, you should modify AuthenticationMode to cause PrintWhere to
prompt for credentials.

XML Syntax

Registry Entry
Values

<serviceURL>
string
</serviceURL>
ServiceURL string
string represents the Service URL for your PrinterOn solution.

Third-party integration settings
Description

The ClientUID, SessionMetaData, and EnableSessionClientUID specify
information used by some third-party integrations.
You can also specify whether the user is permitted to edit the client UID and
session metadata content.

XML Syntax

<clientUID>
string
</clientUID>
<sessionMetaData>
string
</sessionMetaData>
<EnableSessionClientUID>
value
</EnableSessionClientUID>
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Registry Entries

Values

ClientUID string
SessionMetaData stringEnableSessionClientUID value
string represent user information required by your third-party integration.
value can be one of:
0: The user cannot modify the client UID and session values.
1: The user can modify the client UID and session values.
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D
Troubleshooting PrintWhere
Locating PrintWhere log files
Should you have problems printing with the PrintWhere universal printer
driver, you may need to access the PrintWhere log files to help diagnose the
problem.
PrintWhere saves log information to the following file:
•

On Windows versions earlier than Windows 10:
C:\ProgramData\PrinterOn Corporation\PONData\Logs\
PrintWhere 6.0\PWCDRV60.log

•

On Windows 10:
C:\Users\<user>\AppData\Local\PrinterOn Corporation\
PrintWhere 6.0\PWCDRV60.log

Problems associated with the installation of PrintWhere are save to the
following log file:
C:\Program Files\PrinterOn Corporation\pwcInstall60.log.

Determining which PrintWhere edition you have installed
You can determine which edition you have installed by viewing the About
dialog. The About dialog displays version information about PrintWhere and
lists the printer drivers that were installed with the PrintWhere software.
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If there are no drivers listed, then PrintWhere LE was installed. Otherwise, the
full version of PrintWhere was installed.
To view the About dialog:
•

In the Printer Manager, click the Information icon.

The About dialog appears.
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Trademarks and service marks
The following are trademarks or registered trademarks of PrinterOn Inc. in Canada and other countries:
PrinterOn®, PrintAnywhere®, Print Simply Anywhere®, PrintWhere®, PRINTSPOTS®, the PrinterOn
Logo, the PrinterOn Symbol, PrintConnect™, Secure Release Anywhere™, and PrintValet™ are
trademarks and/or registered trademarks of PrinterOn.
The following are trademarks or registered trademarks of other companies:
Windows, Internet Explorer, Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Visio
are trademarks or registered trademarks of Microsoft Corporation.
iPad, iPhone, AirPrint, and macOS are trademarks or registered trademarks of Apple.
iOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used by
Apple under license.
Android, Chrome OS, and Chromebook are trademarks or registered trademarks of Google Inc.
BlackBerry is a registered trademark of BlackBerry, Ltd.
Other brands and their products are trademarks or registered trademarks of their respective holders.

Copyright notice
© Copyright 2017 by PrinterOn Inc.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form or by any means, electronic, mechanical, photocopy, recording, or otherwise,
without the prior written permission of PrinterOn Inc.
Disclaimer:
PrinterOn Inc. makes no warranty with respect to the adequacy of this documentation, programs, or
hardware, which it describes for any particular purpose, or with respect to the adequacy to produce
any particular result. In no event shall PrinterOn Inc. be held liable for special, direct, indirect, or
consequential damages, losses, costs, charges, claims, demands, or claim for lost profits, fees, or
expenses of any nature or kind.
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